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Chapter 8  Run FASTDATA Site Utility Processes

�  Overview

This chapter discusses processes and windows available from the Utilities menu. These
processes include maintaining addresses, maintaining credit cards and associated data,
exporting and importing data, handling suspended transactions and expenditures, returning
expenditures to the FA, redistributing costs, quarterly and year end processing, recalculating
obligations, and maintaining credit card data. You also can open the Site Status window from
the Utilities menu. The FASTDATA FA application Site User Maintenance window Site Security
Access options control user access to site utilities. For example, if a user has been assigned No
Access to the Import, Export Data site security access option, that user cannot import or
export data. Access levels include Access, No Access, Update, and Display Only.

The Address Book window allows users to view and maintain addresses used with various
FASTDATA Site documents and document related processes.

The Site Status window allows users to view general information on system attributes, the
status of funds, and assigned serial ranges.

The Credit Card Maintenance window allows users to create, modify, view, and delete records
on credit cards and related cardholders, banks, and vendors.

Export processes allow users to export site data, using the Build Financial Framework, Build
Accounting Batch, Rebuild Accounting Batch, Build UADPS Batch, Rebuild UADPS Batch, Build
Procurement Data, and Rebuild Procurement Data processes. The last two processes are
available only to Standard Procurement System (SPS) sites.

The import comptroller data process allows users to import responsibility center, OPTAR,
authorization, job order number (JON), DMLSS inventory issued and encumbered amounts (for
DMLSS sites), security, serial range, site information, and expenditure transactions data from
the FA. Users also can import external transactions. After importing external transactions the
user can correct, delete, and process any imported transactions that were suspended.

The cost redistribution process allows users to transfer part or all of a valid expenditure amount
to one or more different documents/ACRNs, as well as update and view an existing
redistribution. You can only redistribute expenditures to document(s) that belong to your site.

The Expenditure Correction window allows a user to make changes to an expenditure to
unsuspend it. The Mark Expenditures to Return to the FA window is used to identify and return
expenditures to the FA.

Quarterly processing of transactions allows users to bring authorization amounts into the new
quarter. FASTDATA will notify you when you log into the Site application that it is time to
perform quarterly processing. The Utilities menu Process Quarter item will be unavailable until
you receive the notification.

End-of-year processing allows users to roll your site data into the new fiscal year. The process
automatically removes the oldest fiscal year and its associated data.
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If the site funds, as shown in the Status of Funds Report and the Document Status Log Report
are out of balance, the recalculation process performed from the Job Order Recalculation
window will verify the actual costs of each document and adjust the obligated amounts on each
job order number (JON) to bring them back in balance.

The Suspend Transactions window allows you to mark transactions for suspension that have
not been cross-referenced to a credit card document and that have been created or changed
since the FA last received transactions from your site.

To run a utility process, select the desired item from the FASTDATA Site Utilities menu.

It is important to note that as users convert from the DOS version of FASTDATA to the version
for the Windows® operating system, the FASTDATA software must try to accommodate them.
For import and export processes, the names of files and the number of files you import or export
will depend on whether you are using release 00-2 or later and whether your FA is using the
same release. If both you and your FA are running FASTDATA release 00-2 or later for
Windows, you will import or export files with an MPX extension. Until both you and your FA have
converted to the 00-2 Windows version of FASTDATA, you will continue to use multiple files for
import and export processes.

� Utilities Options

•  View an address

•  Add a new address

•  Update an address

•  Delete an address

•  View system attributes

•  View OPTARs, authorizations, and JONs

•  View serial ranges and assigned documents

Figure 8.1
Utilities Menu
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•  View bank data

•  Add new bank

•  Update bank

•  Delete bank

•  View credit card data

•  Add new credit card

•  Assign cardholder to credit card

•  Unassign cardholder for credit card

•  Update credit card

•  Delete credit card

•  View cardholder data

•  Add new cardholder

•  Update cardholder

•  Delete cardholder

•  Assign credit card to cardholder

•  Unassign credit card for cardholder

•  View vendor data

•  Add new vendor

•  Update vendor

•  Delete vendor

•  Cross-reference Credit Card document

•  Import comptroller data

•  Import, correct, delete, and process external transactions

•  Export build financial framework files
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•  Export build accounting batch files

•  Export rebuild accounting batch files

•  Export build UADPS batch files

•  Export rebuild UADPS batch files

•  Export build procurement data

•  Export rebuild procurement data

•  Add a new redistribution

•  Update/delete an existing redistribution

•  View an existing redistribution

•  Correct suspended expenditures

•  Return expenditure to FA

•  Perform quarterly processing

•  Perform year end processing

•  Recalculate obligations

•  Suspend transactions
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Address Book Window

�  Overview

Use this window to add, update, and maintain names, activity IDs, and addresses for use on site
documents and in other document related processes. When you open the Address Book
window, FASTDATA accesses all entries associated with your site. Address Book entries are
available for selection from drop-down lists on various Site document and document process
windows.

The Address Book window opens from the FASTDATA Site Utilities menu.

Restrictions

•  Access to the Address Book window is unrestricted.

•  Address Book Window Objects

Figure 8.3
Address Book
Window

Figure 8.2
Opening the
Address Book
Window
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Select the search type
You can search the listed addresses by SDN Key, MILSTRIP Key, or Name/Activity. Select
the desired search type from the drop-down list.

Enter the search item
Allows you to enter the desired value for the selected search type. For example, if you selected
SDN Key for the search type, enter the specific key number that you wish to search for.

Select the sort order
Allows you to change the sort order of the data displayed on the Address Book window. Select
the desired value from the drop-down list. Values include SDN Key, MILSTRIP Key, or
Name/Activity.

Ascending
Select the Ascending radio button if you wish to sort the displayed data from smallest to
greatest.

Descending
Select the Descending radio button if you wish to sort the displayed data from greatest to
smallest.

SDN Key
Identifies the five- or six-character Standard Document Number (SDN) address key associated
with a specific address.

MILSTRIP Key
Identifies the three-character Military Standard Requisitioning and Issue Procedures
(MILSTRIP) key.

Name/Activity
Identifies a person or activity that will be available for selection from drop-down lists used with
new Site documents or other document related processes.

Address Line 2
Displays the second line of an address.

Address Line 3
Displays the third line of an address.

Address Line 4
Displays the fourth line of an address.

�  Steps for Viewing an Address

1. From the FASTDATA Site window, select Address Book from the Utilities
menu.

The Address Book window will open and current addresses will display. Use the
scrollbar to view data for all address lines.
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2. From the address list, select the address you wish to view details on. If you know
the SDN or MILSTRIP key for the desired address, you also can select the
appropriate search type and enter the corresponding value for the search item.
FASTDATA will automatically highlight the address for which you specified the
criteria.

3. Right-click on the selected address, then select View from the shortcut menu.

Tip  You  can also open the View Address window by selecting View from the Edit
menu Address item submenu.

The View Address window will open and data on the selected address will display.
Checked check boxes, if any, indicate that address data is available for selection on
the appropriate document drop-down list when creating or updating the associated
document type.

4. Select the Close button to close the View Address window.

Figure 8.4
Opening
the View
Address
Window

Figure 8.5
Viewing
Selected
Address Data
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�  Steps for Adding a New Address

Tip  You also can add an address to the Address Book when you manually enter a
new address or name while creating a new document. As you save the document, a
message will ask if you want to add the new address to the Address Book. Select
Yes on the message to add the new address. If the new address contains a three-
character MILSTRIP key, or a five- or six-character SDN key, FASTDATA will
automatically make the value available on the appropriate drop-down lists for the
applicable document types. Refer to the Adding a New Address Book Entry When
Saving a New Document reference help topic for additional information.

1. From the FASTDATA Site window, select Address Book from the Utilities
menu.

The Address Book window will open and current addresses will display.

2. Select New from the Edit menu Address item submenu, or right-click anywhere
within the data area of the Address Book window and select the New item on the
shortcut menu.

The Add Address window will open.

3. If applicable, enter the appropriate MILSTRIP or SDN Key.
4. Enter the required first address line data in the Name/Activity field.
5. Enter the optional data for the remaining address lines.
6. If applicable, check or uncheck the desired document associated check boxes.

You also can accept the default selections based on whether you entered a
MILSTRIP key, five-character SDN key, or a six-character SDN key. A single
asterisk (*) next to a check box indicates an item associated with a MILSTRIP
key. A double asterisk (**) indicates an item associated with an SDN key.

Figure 8.6
Adding a New
Address
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7. Select the Save button. FASTDATA will display a message asking you if you
would like to add another address.

8. If you have more addresses to add, select the Yes button and continue entering
new address data.

9. When you have entered all desired new addresses, select the No button to save
the new data and close the Add Address window.

�  Steps for Updating an Address

1. From the FASTDATA Site window, select Address Book from the Utilities
menu.

The Address Book window will open and current addresses will display. Use the
scrollbar to view data for all address lines.

2. From the address list, select the address you wish to edit. If you know the SDN
or MILSTRIP key for the desired address, you also can select the appropriate
search type and enter the corresponding value for the search item. FASTDATA
will automatically highlight the first address for which you specified the criteria.
Double-click on the desired address.

Figure 8.7
Adding Additional
Addresses

Figure 8.8
Selecting an
Address to
Update
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The Edit Address window will open.

Tip  You can also open the Edit Address window for the desired address by selecting
Update from the Edit menu Address item submenu, or by right-clicking on the
selected address and selecting Update on the shortcut menu.

3. Modify the desired data.
4. Select the Save button to save the change. The Edit Address window will close.

Tip  The Save button becomes available for selection after you make a change to
the selected address.

�  Steps for Deleting an Address

1. From the FASTDATA Site window, select Address Book from the Utilities
menu.

The Address Book window will open and current addresses will display.

2. Select the address you wish to delete.

Figure 8.9
Editing an
Address
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3. Select Delete from the Edit menu Address item submenu, or right-click on the
selected address and select the Delete item on the shortcut menu. FASTDATA
will ask you to confirm the deletion.

4. Select the Yes button to confirm the address deletion. The selected address will
be deleted from the database.

NOTE  If you delete an address that is used within a document, the address will not
be deleted from the document. Address book data is stored separately within the
database.

Site Status Window

�  Overview

Use this window to view information on your site. The Site Status window has three tabs:
General, Status of Funds, and Serial Ranges. Select the desired tab for more information on
your site.

The Site Status window opens from the FASTDATA Site Utilities menu.

Restrictions

•  Access to the Site Status window is unrestricted.

Figure 8.11
Opening the Site
Status Window

Figure 8.10
Deleting an
Address
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•  Site Status Window Objects

General Tab
Provides general information about your FASTDATA site, including site and system
characteristics.

Status of Funds Tab
Displays data about your site's funds.

Serial Ranges Tab
Provides information on the serial number ranges associated with your site.

OK
Closes the Site Status window.

Help
Opens the reference help topic on the Site Status window.

Figure 8.12
Site Status
Window
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�  Steps for Viewing System Attributes

1. From the FASTDATA Site window, select Site Status from the Utilities menu.

The Site Status window will open with the General tab selected by default. Site and
system attributes will display.

2. Select the OK button to close the Site status window.

�  Steps for Viewing OPTARs, Authorizations, and JONs

1. From the FASTDATA Site window, select Site Status from the Utilities menu.

The Site Status window will open with the General tab selected by default.

2. Select the Status of Funds tab on the Site Status window. OPTARs assigned to
the site will display.

Figure 8.13
Viewing Site
and System
Attributes
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3. If you wish to view authorizations, select the desired operating target (OPTAR)
for which you wish to view authorizations from the OPTAR's Assigned to Site
list box and select the Authorizations button.

Associated authorizations will display. Use the scrollbar to modify the view of the
data.

Figure 8.14
Viewing
OPTARs

Figure 8.15
Viewing
Authorizations
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4. If you wish to view job orders, select the desired authorization for which you wish
to view job orders from the Authorizations for OPTAR list box and select the
Job Orders button.

Tip  To return to the OPTAR data, select the Back button.

Associated JONs will display. Use the scrollbar to modify the view of the data.

5. Select the Back button to return to authorizations or select the OK button on the
Site Status window to close the window.

�  Steps for Viewing Serial Ranges and Assigned
Documents

1. From the FASTDATA Site window, select Site Status from the Utilities menu.

The Site Status window will open with the General tab selected by default.

2. Select the Serial Ranges tab on the Site Status window. Serial ranges assigned
to the site will display.

Figure 8.16
Viewing Job
Orders
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3. Select the serial range for which you wish to view assigned documents and
select the Assigned Documents button.

The Assigned Documents window will open. Documents are assigned when the
adjacent check box is checked.

4. Select the OK button to close the Assigned Documents window.
5. On the Site Status window, select the OK button to close the window.

Figure 8.18
Viewing
Assigned
Documents

Figure 8.17
Viewing
Serial
Ranges
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Credit Card Maintenance Window

�  Overview

Use this window to create, modify, view, and delete records on credit cards and related
cardholders, banks, and vendors. The Credit Card Maintenance window has four tabs: Bank,
Credit Card, Cardholder, and Vendor. Select the desired tab, then right-click in the upper
window area to access a shortcut menu of options. You can also access a specific option by
selecting the desired item from the Edit menu. Access to credit card maintenance processes is
defined at the FA level. Users will have update, view-only, or no access to these processes.

After you add the desired banks, you can add the desired credit cards to associate with the
banks. After you add the credit cards, you can assign cardholders to the credit card records.
Because the banks, credit cards, cardholders, and vendors are related, you cannot delete one
type of record if it has associations with other records. For example, if you want to delete a bank
record, you cannot do so if the bank has a credit card associated with it. Similarly, if you want to
delete a credit card, you cannot do so if there is a cardholder associated with the credit card in
FASTDATA. Vendor data is for use on the memo Credit Card document. If a memo Credit Card
document has a vendor specified, you cannot delete that vendor record.

The Credit Card Maintenance window opens from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Update under Credit Card can maintain data on the Credit Card
Maintenance window.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
View-Only under Credit Card limits users to view-only access to credit card data.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Credit Card prevents a user from accessing the Credit Card
Maintenance window.

Figure 8.19
Opening the Credit
Card Maintenance
Window
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•  Credit Card Maintenance Window Objects

Bank Tab
Lists the banks for your site. From this tab you can add, update, and remove banks for your site,
as well as view existing bank data. Select the desired bank in the upper list to view associated
credit cards in the lower window area.

Credit Card Tab
Lists the credit cards for your site's banks. From this tab you can add, update, and remove
credit cards for a selected bank, as well as view existing credit card data. Select the desired
bank in the upper list to view associated cardholders in the lower window area.

Card Holder Tab
Lists the personnel at your site who have been issued credit cards. From this tab you can add,
update, and remove cardholders for your site; as well as view existing cardholder data. Select
the desired cardholder in the upper list to view assigned credit cards in the lower window area.

Vendor Tab
Lists your site's vendors available for credit card purchases. From this tab you can add, update,
and remove vendors for your site.

�  Steps for Viewing Bank Data

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Available banks for your site and associated credit cards, if any, are
displayed on the tab.

Figure 8.20
Credit Card
Maintenance
Window
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2. Select the bank you wish to view data on.

3. Right-click in the upper window area of the tab and select View from the shortcut
menu. The View Bank window will open and data on the selected bank will
display.

Tip  You can also open the View Bank window by selecting the Edit menu Bank
submenu, then selecting View.

4. Select the Close button to close the View Bank window.

Figure 8.21
Opening the
View Bank
Window

Figure 8.22
Viewing Bank
Data
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�  Steps for Adding New Bank

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Available banks for your site and associated credit cards, if any, are
displayed on the tab.

2. Right-click in the upper window area of the tab and select New from the shortcut
menu. The New Bank window will open.

Tip  You can also open the New Bank window by selecting the Edit menu Bank
submenu, then selecting New.

3. Enter the required name of the financial institution that has, or will have, a military
purchase card account for your site in the Bank field. You can enter up to 60
characters.

4. Enter the required first address line data and city data.
5. Select the required state from the State drop-down list.
6. Enter the required Zip code.
7. If you wish, enter any optional data in the remaining fields.
8. Select the Save button.

Figure 8.23
Adding a New
Bank
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FASTDATA will inform you that the new bank has been successfully saved and
display a message asking you if you would like to add another bank.

9. If you have more banks to add, select the Yes button and continue entering new
data.

10. When you have entered all desired new banks, select the No button to save the
new data and close the New Bank window.

The new data will display on the Credit Card Maintenance window Bank tab.

�  Steps for Updating Bank

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Available banks for your site and associated credit cards, if any, are
displayed on the tab.

2. Select the bank that you wish to update.
3. Right-click in the upper window area of the tab and select Update from the

shortcut menu. The Update Bank window will open.

Tip  You can also open the Update Bank window by selecting the Edit menu Bank
submenu, then selecting Update.

Figure 8.24
Adding
Additional
Banks
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4. Modify the desired data.

5. Select the Save button to save the change. The Update Bank window will close
and the modified data will display on the Credit Card Maintenance window Bank
tab.

�  Steps for Deleting Bank

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Available banks for your site and associated credit cards, if any, are
displayed on the tab.

2. Select the bank that you wish to delete.
3. Right-click in the upper window area of the tab and select Delete from the

shortcut menu.

Tip  You can also delete a bank by selecting the Edit menu Bank submenu, then
selecting Delete.

NOTE  You cannot delete a bank if it has any associated credit cards.

Figure 8.25
Updating Bank
Data
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FASTDATA will ask you to confirm the deletion.

4. Select the Yes button to confirm the bank deletion. The selected bank will be
deleted from the database.

�  Steps for Viewing Credit Card Data

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Credit Card tab. Available credit cards and associated
cardholders, if any, are displayed on the tab.

2. Select the credit card for which you wish to view data.

Figure 8.26
Deleting a
Bank

Figure 8.27
Opening the
View Credit
Card Window
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3. Right-click in the upper window area of the tab and select View from the shortcut
menu. The View Credit Card window will open and data on the selected card will
display.

Tip  You can also open the View Credit Card window by selecting the Edit menu
Credit Card submenu, then selecting View.

4. Select the Close button to close the View Credit Card window.

�  Steps for Adding New Credit Card

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Credit Card tab. Available credit cards and associated
cardholders, if any, are displayed on the tab.

2. Right-click in the upper window area of the tab and select New from the shortcut
menu. The New Credit Card window will open.

Tip  You can also open the New Credit Card window by selecting the Edit menu
Credit Card submenu, then selecting New.

Figure 8.28
Viewing Credit
Card Data
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3. Select the desired value that identifies the financial institution associated with the
credit card that you are adding. You must select a value from the Bank drop-
down field.

4. Enter the required 16-digit number of the card in the Credit Card Number field.
5. Briefly describe the credit card you’re adding in the Description field. You must

enter a description.
6. Enter the required maximum outstanding amount the credit card account can

have at any time in the Credit Limit field.
7. Enter the required name of the person responsible for reviewing and verifying

monthly purchase card statements of cardholders in a given locale or group in
the Approving Official field.

8. Enter the required five-character code in the Approving Official UIC (Unit
Identification Code) field.

9. If you wish, enter any optional data in the remaining fields.
10. Select the Save button.

Figure 8.29
Adding a New
Credit Card
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FASTDATA will inform you that the new credit card has been successfully saved and
display a message asking you if you would like to add another card.

11. If you have more credit cards to add, select the Yes button and continue entering
new data.

12. When you have entered all desired new credit cards, select the No button to
save the new data and close the New Credit Card window.

The new data will display on the Credit Card Maintenance window Credit Card tab.

�  Steps for Assigning Cardholder to a Credit Card

1. On the Credit Card Maintenance window Credit Card tab, select the credit card
that you wish to assign a cardholder to.

2. Right-click in the upper window area of the tab and select Assign Cardholder
from the shortcut menu. The Assign Credit Card to Cardholder window will open.

Figure 8.30
Adding
Additional
Credit Cards

Figure 8.31
Assigning
Credit Card to
Cardholder
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3. Select the required name from the Cardholder Name drop-down field.

Tip  The individual that you wish to assign as a cardholder for a credit card must
exist in the database as a valid cardholder. To add a new cardholder to the
database, refer to the section on Steps for Adding a New Cardholder.

4. Select the Save button to save the new cardholder assignment. The Assign
Credit Card to Cardholder window will close and the assignment will display on
the Credit Card Maintenance window Credit Card tab Assigned Cardholder list
box.

�  Steps for Unassigning Cardholder for a Credit Card

1. On the Credit Card Maintenance window Credit Card tab, select the credit card
for which you wish to remove a cardholder assignment.

2. Right-click in the upper window area of the tab and select Unassign Cardholder
from the shortcut menu. The Unassign Cardholder window will open.

3. If applicable, select the person for whom you wish to delete the credit card
assignment.

NOTE  You cannot delete a cardholder association if the individual is referenced on
credit card documents.

4. Select the Save button. The Unassign Cardholder window will close and the
applicable assignment is removed from the Credit Card Maintenance window
Credit Card tab Assigned Cardholder list box.

Figure 8.32
Removing
Credit Card
Assignment
from
Cardholder
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�  Steps for Updating Credit Card

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Credit Card tab. Available credit cards and associated
cardholders, if any, are displayed on the tab.

2. Select the credit card that you wish to update.
3. Right-click in the upper window area of the tab and select Update from the

shortcut menu. The Update Credit Card window will open.

Tip  You can also open the Update Credit Card window by selecting the Edit menu
Credit Card submenu, then selecting Update.

4. Modify the desired data.

5. Select the Save button to save the change. The Update Credit Card window will
close and the modified data will display on the Credit Card Maintenance window
Credit Card tab.

Figure 8.33
Updating
Credit Card
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�  Steps for Deleting Credit Card

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Credit Card tab. Available credit cards and associated
cardholders, if any, are displayed on the tab.

2. Select the credit card that you wish to delete.
3. Right-click in the upper window area of the tab and select Delete from the

shortcut menu.

Tip  You can also delete a credit card by selecting the Edit menu Credit Card
submenu, then selecting Delete.

NOTE  You cannot delete a credit card if it has any assigned cardholders.

FASTDATA will ask you to confirm the deletion.

4. Select the Yes button to confirm the credit card deletion. The selected card will
be deleted from the database.

�  Steps for Viewing Cardholder Data

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Cardholder tab. Cardholders currently in the system are
displayed.

Figure 8.34
Deleting a
Credit Card
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2. If applicable, select the cardholder for whom you wish to view data.

3. Right-click in the upper window area of the tab and select View from the shortcut
menu. The View Cardholder window will open and data on the selected individual
will display.

Tip  You can also open the View Cardholder window by selecting the Edit menu
Cardholder submenu, then selecting View.

4. Select the Close button to close the View Cardholder window.
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�  Steps for Adding New Cardholder

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Cardholder tab. Cardholders currently in the system are
displayed.

2. Right-click in the upper window area of the tab and select New from the shortcut
menu. The New Cardholder window will open.

Tip  You can also open the New Cardholder window by selecting the Edit menu
Cardholder submenu, then selecting New.

3. Enter the required first and last names in the First Name and Last Name fields.
4. If the new cardholder is an approving official (AO) or agency program coordinator

(APC), check the applicable check box.
5. If you wish, enter any optional data in the remaining fields.
6. Select the Save button.

Figure 8.37
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FASTDATA will inform you that the new cardholder has been successfully saved and
display a message asking you if you would like to add another cardholder.

7. If you have more cardholders to add, select the Yes button and continue entering
new data.

8. When you have entered all desired new cardholders, select the No button to
save the new data and close the New Cardholder window.

The new data will display on the Credit Card Maintenance window Cardholder tab.

�  Steps for Assigning Credit Card to a Cardholder

1. On the Credit Card Maintenance window Cardholder tab, select the cardholder
you wish to assign a credit card.

2. Right-click in the upper window area of the tab and select Assign Credit Card
from the shortcut menu. The Assign Credit Card to Cardholder window will open.
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3. Select the required value from the Credit Card Number drop-down field.

Tip  The credit card that you wish to assign to a cardholder must exist in the
database as a valid card. To add a new credit card to the database, refer to the
section on Steps for Adding a New Credit Card.

4. Select the Save button to save the new credit card assignment. The Assign
Credit Card to Cardholder window will close and the assignment will display on
the Credit Card Maintenance window Cardholder tab Assigned Credit Cards
list box.

�  Steps for Unassigning Credit Card for a Cardholder

1. On the Credit Card Maintenance window Cardholder tab, select the cardholder
from whom you wish to remove a credit card assignment.

2. Right-click in the upper window area of the tab and select Unassign Credit Card
from the shortcut menu. The Unassign Credit Card window will open.

3. If applicable, select the credit card you wish to delete from the selected
cardholder.

4. Select the Save button. The Unassign Credit Card window will close and the
applicable assignment is removed from the Credit Card Maintenance window
Cardholder tab Assigned Credit Cards list box.

�  Steps for Updating Cardholder

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Cardholder tab. Cardholders currently in the system are
displayed.
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2. Select the cardholder that you wish to update.
3. Right-click in the upper window area of the tab and select Update from the

shortcut menu. The Update Cardholder window will open.

Tip  You can also open the Update Cardholder window by selecting the Edit menu
Cardholder submenu, then selecting Update.

4. Modify the desired data.

5. Select the Save button to save the change. The Update Cardholder window will
close and the modified data will display on the Credit Card Maintenance window
Cardholder tab.

�  Steps for Deleting Cardholder

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Cardholder tab. Cardholders currently in the system are
displayed.

2. Select the cardholder that you wish to delete.
3. Right-click in the upper window area of the tab and select Delete from the

shortcut menu.

Tip  You can also delete a cardholder by selecting the Edit menu Cardholder
submenu, then selecting Delete.

NOTE  You cannot delete a cardholder who is referenced on a Credit Card
document.
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FASTDATA will ask you to confirm the deletion.

4. Select the Yes button to confirm the cardholder deletion. The selected cardholder
will be deleted from the database.

�  Steps for Viewing Vendor Data

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Vendor tab. Vendors currently available for your site are
displayed.

2. If applicable, select the vendor for whom you wish to view data.
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3. Right-click on the tab and select View from the shortcut menu. The View Vendor
window will open and data on the selected individual will display.

Tip  You can also open the View Vendor window by selecting the Edit menu
Cardholder submenu, then selecting View.

4. Select the Close button to close the View Vendor window.

�  Steps for Adding New Vendor

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Vendor tab. Vendors currently available for your site are
displayed.

2. Right-click on the tab and select New from the shortcut menu. The New Vendor
window will open.

Tip  You can also open the New Vendor window by selecting the Edit menu Vendor
submenu, then selecting New.
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3. Enter the required name of the business in the Vendor field. You can enter up to
30 characters.

4. Enter the required street or mailing address data in the Address, City, State,
and Zip fields.

5. If desired, check the applicable check boxes to indicate if the new vendor is
currently, or was previously, a small, small disadvantaged, and/or women-owned
business.

6. If you wish, enter any optional data in the remaining fields.
7. Select the Save button. FASTDATA will inform you that the new vendor has been

successfully saved and display a message asking you if you would like to add
another vendor.
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8. If you have more vendors to add, select the Yes button and continue entering
new data.

9. When you have entered all desired new vendors, select the No button to save
the new data and close the New Vendor window.

�  Steps for Updating Vendor

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Vendor tab. Vendors currently available for your site are
displayed.

2. Select the vendor that you wish to update.
3. Right-click on the tab and select Update from the shortcut menu. The Update

Vendor window will open.

Tip  You can also open the Update Vendor window by selecting the Edit menu
Vendor submenu, then selecting Update.

4. Modify the desired data.

5. Select the Save button to save the change. The Update Vendor window will
close and the modified data will display on the Credit Card Maintenance window
Vendor tab.

Figure 8.47
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�  Steps for Deleting Vendor

1. From the FASTDATA Site window, select Credit Card Maintenance from the
Utilities menu.

The Credit Card Maintenance window will open with the Bank tab selected by
default. Select the Vendor tab. Vendors currently available for your site are
displayed.

2. Select the vendor that you wish to delete.
3. Right-click on the tab and select Delete from the shortcut menu.

Tip  You can also delete a vendor by selecting the Edit menu Vendor submenu,
then selecting Delete.

NOTE  You cannot delete a vendor record that is referenced on a Credit Card
document.

FASTDATA will ask you to confirm the deletion.

4. Select the Yes button to confirm the vendor deletion. The selected record will be
deleted from the database.

Credit Card X-Ref Window

�  Overview

Use this window to cross-reference a Credit Card document (either created manually with the
Site software or imported through an MPC import) to a requisition DCN/ACRN. The Credit Card
X-Ref window lists credit card transactions available for cross-referencing.

Figure 8.48
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If you created a requisition document to reserve funds for an MPC purchase transaction, you
can cross-reference a Credit Card document to the desired requisition document to generate a
reversal transaction for the requisition. When you cross-reference a Credit Card document by
selecting a value for Requisition/ACRN, the document will automatically be marked for release
to the FA.

You also can cross-reference an imported MPC transaction to a manually created Credit Card
document. Doing so will cite the CitiDirect-generated DCN of the MPC transaction as the Bank
DCN for the manually created Credit Card document. You can cross-reference multiple MPC
transactions to the same Credit Card document.

Additionally, you can cross-reference a manually created Credit Card document to another
manually created Credit Card document. This is a one-to-one cross-reference; no other MPC or
manual Credit Card document can reference either of the two cross-referenced manually
entered Credit Card documents.

The Credit Card X-Ref window opens from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under Import, Export Data can cross-reference credit card
documents on the Credit Card X-Ref window.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Import, Export Data prevents a user from accessing the Credit Card
X-Ref window.

Figure 8.49
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•  Credit Card X-Ref Window Objects

Select the search type
You can search by DCN or Vendor. Select the desired value from the drop-down list.

Enter the search item
Allows you to enter the desired value for the selected search type. For example, if you selected
DCN for the search type, enter the desired DCN in this field.

Select the sort order
Allows you to change the sort order of the data displayed on the Select Document window.
Select the desired value from the drop-down list. Valid values include Amount, DCN, and
Vendor.

Ascending
Select the Ascending radio button if you wish to sort the selected sort order data in ascending
order.

Descending
Select the Descending radio button if you wish to sort the selected sort order data in
descending order.

Release
Indicates whether the reversal transaction for the cited requisition document will be included in
the site export to the FA.

DCN
Identifies the credit card transaction DCN.

Amendment
Identifies the five-digit amendment number.

ACRN
Identifies the credit card transaction ACRN.

Figure 8.50
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MPC
Indicates whether the credit card transaction was imported through the MPC import process.
Yes indicates the transaction was imported; No indicates the transaction was created manually
on the New Memo Credit Card window.

P/F
Indicates whether the obligation is to be partially (Partial) or fully (Final) liquidated when
processing the transaction. Select the desired value from the drop-down list.

Amount
Identifies the ACRN-obligated amount on the document. This amount will be the total from all
line items for the Credit Card memo.

Requisition/ACRN
Identifies the requisition DCN and ACRN that has been cross-referenced with the listed credit
card transaction. Select the desired value from the drop-down list.

Transaction Date
Identifies the date and time the transaction occurred or the date the document was created.

Vendor
Identifies the business providing a service or product.

Select All
Selects for release all reversal transactions associated with the cited requisition documents for
export to the FA.

Unselect All
Deselects for release all reversal transactions associated with the cited requisition documents
for export to the FA.

Save
Saves your changes on the Credit Card X-Ref window and closes the window.

Cancel
Closes the Credit Card X-Ref window.

Help
Opens the reference help topic on the Credit Card X-Ref window.
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�  Steps for Cross-Referencing Credit Card Document

1. From the FASTDATA Site window, select Credit Card X-Ref from the Utilities
menu.

The Credit Card X-Ref window will open and display credit card transactions
available for cross-referencing. If desired, use the search type, item, or sort order
criteria to locate a specific document or documents.

2. Select the desired value from the Requisition/ACRN drop-down list for each
document you want to cross-reference to a requisition document.

NOTE  You cannot release a document for export without an associated
requisition/ACRN.

Tip  You also can remove a cross-reference by selecting the first listed value, a
blank line, from the Requisition/ACRN drop-down list. When you select a
Requisition/ACRN value, the Release check box will automatically be checked. If
you remove a cross-reference by selecting the blank line for Requisition/ACRN, the
Release check box will automatically uncheck.

NOTE  When you select a Requisition/ACRN value, you must also indicate a value
for the Partial/Final indicator. Select Final only when you wish to fully liquidate the
transaction that reserved funds for the Credit Card purchase. If you erroneously
liquidate the associated requisition/ACRN, the only way to restore the remaining
balance on the document is to create a new document to reserve the funds.

3. To change the Partial/Final value for a listed transaction, select the desired
value from the drop-down list.

4. If you do not wish to include any updated transaction in the next export to the FA,
uncheck the Release check box.
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Tip  You can also use the Select All or Unselect All buttons to select or deselect all
reversal transactions associated with the cited requisition documents for release to
the FA.

5. When you have made all desired changes, select the Save button. The Credit
Card X-Ref window will close if FASTDATA was able to successfully cross-
reference the selected document(s).

Import Comptroller Data and External Interface Data
Windows

�  Overview

The Select a Folder window, as well as the Import External Transactions window, are used to
specify the folder in which the various import data files are located. After you import external
transactions to your site, you can then correct, delete, and process suspended transactions.
Window objects are shown only for the Select a Folder window. If you wish to know object
details on other associated windows, refer to the applicable topic in FASTDATA Site Reference
Help.

The import comptroller data process opens from the FASTDATA Site Utilities menu.

The external interface processes open from the FASTDATA Site Utilities menu External
Interface submenu.
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Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under Import/Export Data can import data.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Import/Export Data prevents a user from accessing the import
windows.

•  Select a Folder Window Objects

Folder name
Identifies the drive letter and folder where the file will be saved.

Browse
Opens the Select Path window, allowing you to locate the drive, folder, and file name for the
import file.

OK
Initiates the import expenditures process.

Cancel
Aborts the action to import expenditures.

Help
Opens the reference help topic on the Import Expenditures window.

�  Steps for Importing Comptroller Data

Use this process to import responsibility center, OPTAR, authorization, JON, DMLSS
inventory issued and encumbered amounts (for DMLSS sites), security, serial range,
site information, and expenditure transactions data from the FA.

Tip  If you and your FA share an Oracle database and your FA exports data to you
automatically, you do not need to import comptroller data manually.

Figure 8.54
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For users running FASTDATA release 00-2 or later for the Windows® operating
system, the application will import one file with an MPX extension; otherwise, the
system information file names needed for the import process are AC20, AC30,
AC40, AC50, AC60, AC70, AC80, and AC90. When you import expenditure data
from the FA, if the DCN on a transaction is active at the site, FASTDATA
automatically will update the appropriate files. If the DCN has been canceled, the
document will be reinstated. If the DCN is active but FASTDATA does not find a
matching transaction, the transaction will be created as a non-preceded expenditure
transaction. Funds balances are adjusted accordingly.

1. Select Import Comptroller Data from the Utilities menu.

The Select a Folder window will open. The default drive displayed on the Folder
name field is A.

NOTE  Before you can import the desired files, you must know the location of the
files you are going to import. The expenditures file name(s) depend on the
FASTDATA version you and your FA are running.

2. Specify the drive letter and folder from which you wish to import the file by
entering the required path in the Folder name field. You can also select the
Browse button to open the Select Path window.

Figure 8.55
Selecting the
Import
Comptroller
Data Process

Figure 8.56
Select a Folder
Window



Chapter 8 •   Run FASTDATA Site Utility Processes

August 2003 8 – 47 FASTDATA Site Module User’s Manual

Use the Select Path window to locate the folder in which the import file resides. The
window displays the folders available for the selected drive. The default drive is A. In
the example shown, drive D has been selected. To change drive letters, select the
desired drive from the Drives drop-down list. Double-click on the desired Folder.
Select the OK button to close the Select Path window. The chosen path displays on
the Select a Folder window Folder name field.

3. On the Select a Folder window, select the OK button to begin the import
expenditures process.
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A series of messages on the Import Comptroller Data window will display and inform
you on the import process. If the import contains a locked or unlocked status for the
site, FASTDATA will display a stand-alone message informing you so.

If, during the Import Comptroller Data process, the system detects new User IDs
the FastData User Import window will open.

Authorized users are displayed in the Database Id fields. Verify the listed database
IDs and make corrections, if necessary. When you are done, select the OK button.

NOTE  The FastData User Input window will display only if the system detects new
database user IDs during the Import Comptroller Data process and a FASTDATA
version older than release 00-2 is still in use by you or your FA.

4. On the Import Comptroller Data window, if you wish to print the report, select the
Print button to open the Quick Print – Import Comptroller Data window.
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Use the horizontal and vertical scrollbars to scroll through the report. If you wish to
print the report, select the Print picture button.

5. Select the Close button to close the Quick Print – Import Comptroller Data
window.

6. On the Import Comptroller Data window, select the Close button to close the
window.

�  Steps for Importing, Correcting, Deleting, and
Processing External Transactions

Use the import external transactions process to import transactions from systems
outside of FASTDATA. The external systems that currently send transactions to
FASTDATA are the Automated Travel Order System Plus (ATOSPlus), a travel and
transportation system, the Inbound Interface for B1 file formats, the Defense Travel
System (DTS) Transactions from STARS-FL, and the Military Purchase Card (MPC)
system. You also can import acceptance of DD448, DD1556, NC2275, and NC2276
documents from the Acceptance Interface external system.

When you successfully import a file from an external system, FASTDATA creates an
accounting transaction for each external transaction and stores any suspended
transactions for future correction, deletion, or reprocessing. If you imported an MPC
file, the application will create a Memo Credit Card document or document
amendment for each imported MPC transaction that is not suspended. An MPC
transaction will suspend if it does not have a valid DCN, JON, or Expense Element.

If the external ATOSPlus or Inbound Interface file contains a transaction for an
NC2276 document with a commitment amount of $25,000 or greater, FASTDATA will
not import the transaction unless the NC2276 has been accepted.
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The Acceptance Interface file you import can include DD448, DD1556, NC2275, and
NC2276 documents. For this import type, FASTDATA creates acceptance data for
each transaction that is not suspended. For rejected documents, you must manually
create or update the document acceptance using the New or Update Acceptance
process. For imported NC2275, NC2276, and DD1556 documents, FASTDATA will
create a new AO obligation. For imported Category 1 DD448 documents, an AR
obligation is created.

The DTS file you import will contain new or adjustment travel transactions only. For
each DTS transaction that is new and does not suspend, FASTDATA will create the
supporting DD1610 memo document; the document will be marked as exported so if
you select a DTS DD1610 memo to update, the Correction After Export for Travel
Document window will open. You can view these transactions via the Display
DD1610 window.

1. Select Import External Transactions from the External Interface submenu of
the Utilities menu.

The Import External Transactions window will open and allow you to begin the import
process.

2. On the External system list box, select the system from which you wish to
import external transactions.
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In the previous example, ATOSPlus has been selected as the system from which
files are going to be imported. For a discussion of other external systems, refer to the
Select External System topic in FASTDATA Site Reference Help.

3. Specify the drive letter and folder where you wish to save the import file by
entering the required path and file name in the File name field. You can also
select the Browse button to select the desired path.

NOTE  Before you can import the external transactions, you must know their file
location. For ATOSPlus files, the file extension usually is *.SDF or *.TXT. The file
extension for an MPC file is *.MPC. Acceptance Interface file names always begin
with 821. DTS files from STARS-FL are ASCII (American Standard Code for
Information Interchange) files and normally do not have an extension.

Use the Open window to locate the folder from which you wish to import the external
transactions. The window displays the folders available for the selected drive. To
change drive letters, select the desired drive from the Look in drop-down list.
Double-click on the desired Folder to display the files. Select the desired file and
then select the Open button to close the window. The chosen path displays on the
Select External Systems window Folder name field.
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4. On the Select External System window, select the OK button to begin the import
process.

FASTDATA will display two bars showing you the progress of the import process and
then inform you if any of the imported transactions were suspended, or rejected in
the case of a PO/WR import.

5. Select the OK button to acknowledge the message and complete the import
process.

Imported transactions can suspend for many reasons. A transaction will suspend if it
doesn't contain a valid DCN, Expense Element, OMB Object Class, Service Code, or
Not to Exceed values, or if it has a JON that matches an existing JON in FASTDATA.
Additionally, the LOA must be valid. Travel transactions must have a Traveler's
Name and valid Estimated Return Date. Depending on the transaction type, there
are other conditions the transaction must meet or it will suspend.

The Quick Print - Inbound Transaction Report window will open and the valid
inbound transactions and/or rejected inbound transactions will display, as applicable.

Tip  If you’re importing external MPC files, the Quick Print - External Transaction
Report (MPC) window will open instead and display any suspended external MPC
transactions. For imported Acceptance Interface files, the Quick Print - Acceptance
Interface Report will open and display any rejected external transactions.
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Use the horizontal and vertical scrollbars to scroll through the report. If you wish to
print the report, select the Print picture button.

Tip  It's a good idea to print the report or save it as a file if you wish to refer to it later.
Once you close the Quick Print window, the displayed report is no longer available to
you.

6. Select the Close button to close the Quick Print - Inbound Transaction Report
window.

Correcting Suspended Transactions

Use the correct suspended transactions process to correct ATOSPlus or B1
transactions that were suspended during the import external transactions process.
Refer to the Rejected Inbound Transactions report, obtained during the external
transactions import process, for data elements that you need to correct. You also can
create a new transaction by selecting the Insert button.

You cannot correct any suspended imported DTS, MPC, or Acceptance Interface
transactions using the Correct Suspended Transactions process. For MPC
transactions with an Invalid Job Order suspension reason, you can ask your FA to
create the matching JON for the transaction, import the JON into your site, and then
run the Process Suspended Transactions process to unsuspend the MPC
transaction; if the newly created JON meets the necessary criteria, the transaction
will reprocess as valid. The Process Suspended Transactions process revalidates
the imported external transactions and changes suspended transactions to valid
transactions if you have made the necessary corrections or changes.
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1. Select Correct Suspended Transactions from the External Interface submenu
of the Utilities menu.

The Select External System window will open and display the two available systems.

2. Select the system for which you wish to correct transactions and select the OK
button. The Correct Suspended Transactions window will open.

3. Modify the desired value for any editable column to unsuspend the desired
transaction(s).
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Tip  If you want to create a new transaction, select the Insert button. This will insert
a blank row on the Correct Suspended Transactions window, allowing you to create
a new transaction.

4. Select the Save button to save your changes. The Correct Suspended
Transactions window will close. You should now process the corrections by
selecting the Process Suspended Transactions item from the Utilities menu
External Transactions submenu.

Deleting Suspended Transactions

1. Select Delete Suspended Transactions from the External Interface submenu
of the Utilities menu.

The Select External System window will open.

2. Select the system for which you wish to delete transactions and select the OK
button. The Delete Suspended Transactions or Delete Suspended MPC
Transactions window will open, as applicable, and display available suspended
transactions.

3. Select the suspended transactions you wish to delete.
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Tip  To select more than one transaction in the list, click on each transaction you
want to select while holding down the CTRL key. To select multiple transactions that
are listed next to each other, click on the first desired item, then hold down the
SHIFT key and click on the last desired item.

4. Select the Delete button. Selected transactions are deleted from the suspended
transactions list and the OK button will become available for selection.

5. Select the OK button to remove the deleted transactions from the database and
close the Delete Suspended Transactions or Delete Suspended MPC
Transactions window, as applicable.

Processing Suspended Transactions

The Process Suspended Transactions process revalidates the imported external
transactions and changes suspended transactions to valid transactions if you have
made the necessary corrections or changes. You must correct or delete suspended
transactions, as applicable, before you can successfully process previously
suspended transactions.

1. Select Process Suspended Transactions from the External Interface
submenu of the Utilities menu.

The Select External System window will open.

Figure 8.73
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2. On the External system list box, select the system that you wish to process
suspended transactions from.

3. Select the OK button to begin the processing of suspended transactions. If you
successfully corrected all suspended transactions, FASTDATA will inform you
that all transactions were successfully processed. If not, FASTDATA will again
inform you that some transactions were suspended and display the Quick Print
window after you acknowledge the message.

Export Data Windows

�  Overview

Use the various export windows to export the build financial framework and to export build or
rebuilt accounting batch, UADPS batch, procurement data files, and project order/work request
transaction files. Window objects are shown only for the Build UADPS Batch Process window. If
you wish to know object details on other associated windows, refer to the applicable topic in
FASTDATA Site Reference Help.

Remember, the names of files and the number of files you export will depend on whether you
are using FASTDATA Site release 00-2 or later and whether your FA is using the same
FASTDATA release version. If both you and your FA are running FASTDATA release 00-2 or
later for Windows, you will export files with an MPX extension. Until both you and your FA have
converted to the 00-2 Windows version of FASTDATA, or a later version, you will continue to
use multiple files for the export processes.

The export data processes open from the Export submenu of the FASTDATA Site Utilities
menu.

Figure 8.75
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Restrictions

•  Only users with a FASTDATA FA  Module Site User Maintenance window Site Security
Access option of Access under Import/Export Data can export data.

•  A FASTDATA FA Module Site User Maintenance window  Site Security Access option of
No Access under Import/Export Data prevents a user from accessing the export
windows.

•  Build UADPS Batch Process Window Objects

Export
Indicates whether the listed transaction will be included in the UADPS build.

DCN
Lists the DCN for the document.

Amend
Identifies a specific official amendment to a previously established financial document.

Status
Indicates the document or DCN's current status.

OPTAR Log
Identifies the purpose of the entry that will be printed on the OPTAR Log.

Add All
Includes all listed transactions in the UADPS build.

Remove All
Unselects all listed transactions.

Export
Opens a window that allows you to indicate the location of the UADPS file.

Figure 8.76
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Cancel
Aborts the action to build the UADPS batch file and closes the window.

Help
Opens the reference help topic on the Build UADPS Batch Process window.

�  Steps for Exporting Build Financial Framework

Use the financial framework build process to create a file of your site's financial
framework to send to the FA. The financial framework file includes authorization,
JON, and serial range information.

1. Select Build Financial Framework from the Export submenu of the Utilities
menu.

The Select a Folder window will open. The default drive displayed on the Folder
name field is A.

2. Specify the drive letter and folder in which you wish to save the file by entering
the required path in the Folder name field. You can also select the Browse
button to open the Select Path window.

Figure 8.77
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Use the Select Path window to locate the folder into which the export file will be
saved. The window displays the folders available for the selected drive. The default
drive is A. In the example shown, drive C has been selected. To change drive letters,
select the desired drive from the Drives drop-down list. Double-click on the desired
Folder. Select the OK button to close the Select Path window. The chosen path
displays on the Select a Folder window Folder name field.

3. Select the OK button to begin the export financial framework process.

At the end of the conversion process, FASTDATA will inform you that the files were
successfully exported.

4. Select OK on the message. The message window will close.

Figure 8.79
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�  Steps for Exporting Build Accounting Batch Files

Use the build accounting batch process to create a file of your site's financial
framework and current fiscal year's unexported accounting transactions, cost
redistributions, and expenditures you have corrected or are returning to the FA. If
there are no current unexported accounting transactions, cost redistributions, or
expenditures to build, you can build a financial framework file only.

For SPS sites, FASTDATA does not include obligation (AO) transactions that have
been exported to SPS in the accounting batch file. FASTDATA also will not include
DTS transactions imported from STARS-FL in the accounting batch file.

1. Select Build Accounting Batch from the Export submenu of the Utilities menu.

The Select a Folder window will open. The default drive displayed on the Folder
name field is A.

2. Specify the drive letter and folder in which you wish to save the file by entering
the required path in the Folder name field. You can also select the Browse
button to open the Select Path window.

Figure 8.82
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Use the Select Path window to locate the folder into which the export file will be
saved. The window displays the folders available for the selected drive. The default
drive is A. In the example shown, drive C has been selected.  To change drive
letters, select the desired drive from the Drives drop-down list. Double-click on the
desired Folder. Select the OK button to close the Select Path window. The chosen
path displays on the Select a Folder window Folder name field.

3. If you wish to see a printout of the exported file, check the Print Export Report
check box.

4. Select the OK button to begin the export build accounting batch process.

At the end of the conversion process, FASTDATA will inform you that the files were
successfully exported.

5. Select OK on the message. The message window will close.

�  Steps for Exporting Rebuild Accounting Batch Files

Use the rebuild accounting batch process after you have built the accounting batch
file, using the associated build process, and need to build the file again. The last 20
accounting transaction batch files are available for rebuilding.

For SPS sites, FASTDATA does not include obligation (AO) transactions that have
been exported to SPS in the accounting batch file.

Figure 8.84
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1. Select Rebuild Accounting Batch from the Export submenu of the Utilities
menu.

The Select a Batch window will open.

2. If applicable, select the batch you wish to rebuild and select the OK button. The
Select a Folder window will open.

3. Specify the drive letter and folder in which you wish to save the file by entering
the drive letter and path in the required Folder name field. You can also select
the Browse button to open the Select Path window.

Figure 8.85
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Use the Select Path window to locate the folder into which the export file will be
copied. The window displays the folders available for the selected drive. The default
drive is A. In the example shown, drive C has been selected. To change drive letters,
select the desired drive from the Drives drop-down list. Double-click on the desired
Folder. Select the OK button to close the Select Path window. The chosen path
displays on the Select a Folder window Folder name field.

4. Select the OK button to begin the rebuild accounting batch process.

At the end of the conversion process, FASTDATA will inform you that the file was
successfully exported.

5. Select OK on the message. The message window will close.

�  Steps for Exporting Build UADPS Batch Files

Use the build UADPS batch process to create a file of MILSTRIP/MILSTRAP
transactions to be exported. The UADPS (Uniform Automated Data Processing
System) supply system orders materials based on standard DD1348 (MILSTRIP)
input. Because the FASTDATA Site application is the entry point for DD1348s,
building the UADPS batch allows you to order materials without duplicating data
entry. The UADPS build can include all source DD1348 requisitions that were not
included in a previous UADPS batch.

Figure 8.87
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1. Select Build UADPS Batch from the Export submenu of the Utilities menu.

The Build UADPS Batch Process window will open. Documents available for export
are displayed.

2. If you wish to exclude any of the displayed documents from the export file,
uncheck the associated Export check box. All Export check boxes, with the
exception of those cleared for a previous build, are checked by default.

To unselect all listed documents, select the Remove All button. To select all listed
documents, select the Add All button.

3. Select the Export button to begin the export process.

Figure 8.88
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The Enter Location and Name of UADPS Export File window will open.

4. Select the desired folder from the Save in drop-down list and enter the name of
the export file in the File name field. If you wish to change the default file type,
select the desired value from the Save as type drop-down list.

5. Select the Save button to close the Enter Location and Name of UADPS Export
File window.

FASTDATA will inform you that the export has been successfully completed.

6. Select the OK button to acknowledge the message and close the Build UADPS
Batch Process window.

Figure 8.91
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�  Steps for Exporting Rebuild UADPS Batch Files

Use the rebuild UADPS batch process after you have built the UADPS batch file,
using the associated build process, and need to build the file again.

1. Select Rebuild UADPS Batch from the Export submenu of the Utilities menu.

The Select UADPS Batch window will open. Batch numbers available to be rebuilt
are displayed.

2. Select the batch number you wish to rebuild and select the OK button.

Figure 8.92
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The Rebuild UADPS Batch Process window will open. Documents included in the file
to be rebuild are displayed.

Tip  The Add All and Remove All buttons on the Rebuild UADPS Batch Process
window are unavailable for selection. Since this is a batch file that has already been
built, you cannot change the documents to be included.

3. Select the Export button to begin the rebuild process. The Enter Location and
Name of UADPS Export File window will open.

4. Select the desired folder from the Save in drop-down list and enter the name of
the export file in the File name field. If you wish to change the default file type,
select the desired value from the Save as type drop-down list.

5. Select the Save button to close the Enter Location and Name of UADPS Export
File window.

Figure 8.94
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FASTDATA will inform you that the export has been successfully completed.

6. Select the OK button to acknowledge the message and close the Rebuild
UADPS Batch Process window.

�  Steps for Exporting Build Procurement Data Files

Use the build procurement data process to create a file of requisitions for export to
the SPS in electronic data interchange (EDI) format. The build procurement data
process is available only to SPS sites. The build will create a file named 511.txt.

Only procurements from basic source documents are available for export. For
NC2276 procurements, you can select unexported amendments as well as the basic
NC2276. If you select an NC2276 amendment, any earlier unexported amendments
plus the basic document are selected automatically. You cannot export amendments
to other types of source documents.

1. Select Build Procurement Data from the Export submenu of the Utilities menu.

The Select Procurement Data to Export window will open. Documents available for
export are displayed.

Figure 8.96
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2. If you wish to filter the displayed documents, select the desired value from the
Select Filter drop-down list. Available filter values are New, DD1348-6, NC2276,
DD1149, and All. No matter what filter value you select, the procurements list will
not include memo documents; the export procurement data process is for source
documents only.

3. If you wish to exclude any of the displayed documents from the export file,
uncheck the associated Export check box. All Export check boxes, with the
exception of those cleared for a previous build, are checked by default.

To unselect all listed documents, select the Unselect All button. To select all listed
documents, select the Select All button.

4. Select the Export button to begin the export process. The Export Procurement
Data window will open.

5. Specify the drive letter and folder to which you wish to export the file to by
entering the required path in the Location field. You can also select the Browse
button to open the Select Path window.

Figure 8.98
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Use the Select Path window to locate the folder in which the export file will be saved.
The window displays the folders available for the selected drive. In the example
shown, drive D has been selected. To change drive letters, select the desired drive
from the Drives drop-down list. Double-click on the desired Folder. Select the OK
button to close the Select Path window. The chosen path displays on the Export
Procurement Data window  Location field.

6. Select the Export button.

FASTDATA will inform you that the export has been successfully completed.

7. Select the OK button to acknowledge the message.
8. If you wish to print the exported procurement data, select the Print button. The

Quick Print – Export Procurement Data window will open.

Figure 8.100
Export
Procurement
Data Message

Figure 8.101
Quick Print –
Export
Procurement
Data Window



Chapter 8 •   Run FASTDATA Site Utility Processes

FASTDATA Site Module User’s Manual 8 – 72 August 2003

9. Use the horizontal and vertical scrollbars on the Quick Print window to change
the view of the displayed data.

Tip  The scrollbars only allow you to scroll the displayed page. Use the VCR buttons,
if applicable, to select a different page to view.

10. Select the window-specific Print toolbar button to print the data.
11. Select the Close button to close the Quick Print window.
12. Select the Close button to close the Export Procurement Data window.

�  Steps for Exporting Rebuild Procurement Data Files

Use the rebuild procurement data process after you have built a procurement data
file, using the associated build process, and need to build the file again. The process
is available only to SPS sites. The rebuild will create a file named 511.txt.

1. Select Rebuild Procurement Data from the Export submenu of the Utilities
menu.

The Select Procurement Batch window will open. Batch numbers available to be
rebuilt are displayed.

2. Select the batch number you wish to rebuild and select the OK button.

Figure 8.102
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The Procurement Data to Rebuild window will open. Documents included in the file
to be rebuild are displayed.

Tip  The Select All and Unselect All buttons on the Procurement Data to Rebuild
window are unavailable for selection. Since this is a file that has already been built,
you cannot change the documents to be included.

3. Select the Export button to begin the rebuild process. The Rebuild Procurement
Data window will open.

4. Specify the drive letter and folder to which you wish to export the rebuilt file to by
entering the required path in the Location field. You can also select the Browse
button to open the Select Path window.

Use the Select Path window to locate the folder in which the rebuilt file will be saved.
The window displays the folders available for the selected drive. In the example
shown, drive D has been selected. To change drive letters, select the desired drive
from the Drives drop-down list. Double-click on the desired Folder. Select the OK
button to close the Select Path window. The chosen path displays on the Rebuild
Procurement Data window  Location field.

Figure 8.104
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5. Select the Export button.

FASTDATA will inform you that the export has been successfully completed.

6. Select the OK button to acknowledge the message.
7. If you wish to print the exported rebuilt procurement data, select the Print button.

The Quick Print – Rebuild Procurement Data window will open.

8. Use the horizontal and vertical scrollbars on the Quick Print window to change
the view of the displayed data.

Tip  The scrollbars only allow you to scroll the displayed page. Use the VCR buttons,
if applicable, to select a different page to view.

9. Select the window-specific Print toolbar button to print the data.
10. Select the Close button to close the Quick Print window.
11. Select the Close button to close the Rebuild Procurement Data window.

Figure 8.106
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�  Steps for Exporting Build Project Order/Work
Request Data Files

Use the build project order/work request data process to create a file of work
request/project order documents for export to an external system in EDI format. The
Export Project Order/Work Request Data window opens after you select the desired
documents on the Select Project Order/Work Request Data to Export window.

1. To begin the build project order/work request data process, select Build Project
Order/Work Request Data from the Export submenu of the Utilities menu.

The Select Project Order/Work Request Data to Export window will open and display
documents available for export. The list includes only source DD448 and NC2275
documents that have been exported to the FA but have not been accepted nor
canceled, have not been included in a previous Project Order/Work Request export,
and contain all values required for the Project Order/Work Request export process.

2. If you wish to filter the displayed documents, select the desired value from the
Select filter drop-down list. Available filter values are New, DD448, NC2275,
and All.

3. Check the Export check box for each document you wish to include in the
export.
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Tip  You can use the Select All or Unselect All buttons to select or deselect all
displayed documents.

4. Select the Export button. The Export Project Order/Work Request Data window
will open.

5. Specify where FASTDATA will save the export file by entering the drive letter and
folder in the required Location field. You also can select the Browse button to
open the Select Path window to locate the path.

6. Select the Export button.
7. Select the OK button on the message informing you the export was successful.
8. If you wish to print the Export Project Order/Work Request Data report, select the

Print button. The Quick Print - Export Project Order/Work Request Data window
will open.

9. Use the horizontal and vertical scrollbars on the Quick Print window to change
the view of the displayed data.

Figure 8.110
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Tip  The scrollbars only allow you to scroll the displayed page. Use the VCR buttons,
if applicable, to select a different page to view.

10.   Select the window-specific Print toolbar button to print the data.
11.   Select the Close button to close the Quick Print window.
12.   Select the Close button to close the Export Project Order/Work Request Data

window.

�  Steps for Exporting Rebuild Project Order/Work
Request Data Files

Use the rebuild project order/work request data process after you have built a project
order/work request data file, using the associated build process, and need to build
the file again.

1. Select Rebuild Project Order/Work Request Data from the Export submenu of
the Utilities menu.

The Select Project Order/Work Request Batch window will open. Batch numbers
available to be rebuilt are displayed.

Figure 8.112
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2. Select the batch number you wish to rebuild and select the OK button.

The Project Order/Work Request Data to Rebuild window will open. Documents
included in the file to be rebuilt are displayed.

Tip  The Select All and Unselect All buttons on the Project Order/Work Request
Data to Rebuild window are unavailable for selection. Since this is a file that has
already been built, you cannot change the documents to be included.

3. Select the Export button to begin the rebuild process.

The Rebuild Project Order/Work Request Data window will open.

4. Specify the drive letter and folder to which you wish to export the rebuilt file to by
entering the required path in the Location field. You can also select the Browse
button to open the Select Path window to locate the path.

5. Select the Export button. FASTDATA will inform you that the export has been
successfully completed.
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6. Select the OK button to acknowledge the message.
7. If you wish to print the exported rebuilt procurement data, select the Print button.

The Quick Print – Rebuild Project Order/Work Request Data window will open.

8. Use the horizontal and vertical scrollbars on the Quick Print window to change
the view of the displayed data.

Tip  The scrollbars only allow you to scroll the displayed page. Use the VCR buttons,
if applicable, to select a different page to view.

9. Select the window-specific Print toolbar button to print the data.
10. Select the Close button to close the Quick Print window.
11. Select the Close button to close the Rebuild Project Order/Work Request Data

window.

Cost Redistribution Windows

�  Overview

Use the Cost Redistribution windows to create a new redistribution of valid expenditure amounts
to one or more different documents/ACRNs, as well as update and view existing redistributions.
You can only redistribute expenditures to document(s) that belong to your site. DMLSS
transactions are not available for the Cost redistribution process. When selecting a
document/ACRN for cost redistribution you cannot cross short lines of accounting. The amount
you transfer cannot exceed the expended amount.
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The cost redistribution processes open from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access Cost Redistribution access level of Update can enter new redistributions.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access Cost
Redistribution access level of Display-Only limits users to view-only access to existing
redistributions.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access Cost
Redistribution access level of No Access prevents a user from accessing the cost
redistribution processes.

•  Cost Redistribution - New Window Objects

Figure 8.117
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DCN
Identifies the document control number for the expenditure.

Amend
Identifies a specific official amendment to a previously established financial document.

ACRN
Two-character code identifying each long LOA classification cited on an allotment or fund usage
document for the purpose of identifying each LOA during subsequent stages of processing.

Job Order
Identifies the 11-character job order number (JON) used to classify the accounting transaction.

Partial/Final
Indicates whether the obligation is to be fully (F) or partially (C) liquidated when the expenditure
is processed.

Quantity
Indicates the number of items being paid for by the expenditure.

Dist Quantity
Indicates the number of items affected by the redistributed expenditure.

Transaction Amount
Indicates the amount of the transaction.

Distributed Amount
Indicates the amount that will be redistributed.

--Distributed Documents--
This window area provides details of documents selected for redistribution. Unless you change
the default values, FASTDATA will fully liquidate the remaining expenditure amount. Right-click
in this window area to access a shortcut menu that will allow you to add a new redistribution or
delete an existing one.

DCN
Identifies the document control number for the distributed document.

ACRN
Identifies the accounting classification reference number for the distributed document.

Job Order
Identifies the JON for the distributed document.

Partial/Final
Indicates whether the obligation is to be fully (F) or partially (C) liquidated when the expenditure
for the distributed document is processed.

Quantity
Indicates the number of items being paid for by the distributed document expenditure.
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Amount
Identifies the amount of the expenditure that will be redistributed to the listed distributed
document/ACRN. Keep in mind that you cannot change the amount to a value greater than what
is available for redistribution.

Save
Accepts your entries and redistributes the selected expenditure for the distributed document.

Close
Closes the Cost Redistribution - New window.

Help
Accesses the Cost Redistribution – New topic in the reference help file.

�  Steps for Adding a New Redistribution

Use the new redistribution process to transfer part or all of a valid expenditure
amount to one or more different documents/ACRNs. DMLSS transactions are not
available for the Cost Redistribution process.

When you create a new cost redistribution, the process also may generate a 540
(AO) obligation if any of the following circumstances exist:

•  A final expenditure exists.
•  A final receipt exists with no final expenditure and the transaction amount is

greater than the receipt amount less the expenditure amount.
•  There are no final receipts or expenditures and the transaction amount is greater

than the obligation (or the contract amount if a final contract exists) less the
expenditure amount.

•  There is no receipt amount and no expenditure amount and the transaction
amount is greater than the obligation (or the contract amount if a final contract
exists).

1. Select New from the Cost Redistribution submenu of the Utilities menu.

The Select Expenditure to Redistribute window will open. A list of documents that
you can redistribute will display.
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Tip  To search for a specific document, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

2. Select the document you wish to redistribute and select the OK button.

The Cost Redistribution window will open. The upper window area displays
information on the expenditure you are redistributing. The lower area displays
information on documents you select for the redistribution.

3. To begin the redistribution process for the selected document/ACRN, right-click
in the lower window area and select New from the shortcut menu.

Figure 8.120
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The Select Document/ACRN for Redistribution window will open, letting you select
the desired document.

Tip  To search for a specific document, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

4. Select the document/ACRN you wish to redistribute and select the OK button.

Tip  If you want to redistribute the expenditure to more than one document/ACRN,
continue right-clicking and selecting New from the shortcut menu to reopen the
Select Document/ACRN for Redistribution window so that you can select each
desired document.

Figure 8.122
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The Cost Redistribution – New window will display a row of data for each selected
document/ACRN.

5. Update the desired data for the selected document/ACRN.

Tip  The default for a new redistribution is to liquidate fully whatever remaining
expenditure amount exists, but you can change the Amount value. You also can
change default values for Partial/Final and Quantity to control whether the
remaining expenditure amount is fully or partially liquidated.

6. Select the Save button to save the new data. The Cost Redistribution – New
window will close.

�  Steps for Updating/Deleting an Existing
Redistribution

Use the update redistribution process to update an expenditure redistribution. You
can update any redistribution that has not been exported. You also can update
exported redistributions if the expenditure has not been fully liquidated. When
updating an exported partial redistribution, you can add additional
documents/ACRNs for the undistributed amount but cannot delete or modify existing
document/ACRN data.

Figure 8.123
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1. Select Update from the Cost Redistribution submenu of the Utilities menu.

The Select Redistributed Expenditure to Update window will open, letting you select
the desired expenditure.

Tip  To search for a specific document, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

2. Select the redistributed expenditure you wish to update and select the OK button.

Figure 8.124
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The Cost Redistribution – Update window will open. The uppermost window area
displays information on the redistributed expenditure. The lower window area
displays information on the document(s) to which the expenditure costs have been
redistributed.

3. Update the desired data. You can change the Partial/Final, Quantity, and/or
Amount values.

Tip  You also can add a new redistribution to the selected expenditure or delete the
existing redistribution by right-clicking in the lower area of the Cost Redistribution –
Update window and selecting New or Delete, as appropriate, from the shortcut
menu.

4. Select the Save button to save your changes. The Cost Redistribution – Update
window will close.

Figure 8.126
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�  Steps for Viewing an Existing Redistribution

1. Select View from the Cost Redistribution submenu of the Utilities menu.

The Select Redistributed Expenditure to Update window will open, letting you select
the desired expenditure.

Tip  To search for a specific document, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

2. Select the redistributed expenditure you wish to view and select the OK button.

Figure 8.127
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The Cost Redistribution – View window will open. The uppermost window area
displays information on the redistributed expenditure. The lower window area
displays information on the document(s) to which the expenditure costs have been
redistributed.

3. Select the Close button to close the Cost Redistribution – View window.

Correct Suspended Expenditure Process

�  Overview

Use the correct suspended expenditure option to make changes to a suspended expenditure to
unsuspend it. Depending on the reason the expenditure is suspended and how you correct it,
you may create an R type correction transaction that will update the STARS-FL record for the
expenditure or for the requisition. For detailed correction options, refer to the Expenditure
Correction help topic.

The correct suspended expenditure option opens from the FASTDATA Site Utilities menu.
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Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under Expenditure Correction can correct suspended
expenditures.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Expenditure Correction prevents a user from correcting suspended
expenditures.

•  Expenditure Correction Window Objects

Top Window Data Area
DCN
Identifies the document control number.

ACRN
Two-character code identifying each long LOA classification cited on an allotment or fund usage
document for the purpose of identifying each LOA data during subsequent stages of processing.

JON
The 11-character job order number classifies the accounting transaction.

Partial/Final
Indicates whether the obligation is to be fully or partially liquidated when the expenditure is
processed.

Expend Amount
Indicates the amount of the expenditure.

Quantity
Indicates the number of items being paid for by the expenditure.

Expend Date
Identifies the date the expenditure was created.

Status
Indicates the status of the expenditure when it was imported.

Figure 8.131
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Middle Window Data Area
DCN
If the expenditure is suspended because of a non-preceded ACRN, you can select a DCN that
will correct the expenditure.

ACRN
If the expenditure is suspended because of a non-preceded ACRN, you can select an ACRN
that will correct the expenditure.

JON
If the expenditure is suspended because of a JON mismatch, you can select a different JON to
correct the expenditure.

Lower Window Data Area
Obligated Amt
Identifies the ACRN-obligated amount of the document.

Received Amt
Identifies the total amount received against one ACRN of an obligating document.

Expended Amt
Identifies the total amount expended against one ACRN of an obligating document recorded for
all expenditures transactions.

Number Final Receipts
Indicates the number of final receipts posted to the existing transaction.

Number Final Expends
Indicates the number of final expenditures posted to the existing transaction.

Actual Cost
This cost value depends on several conditions. For a detailed explanation of this cost, refer to
the Expenditure Correction help topic.

New Expended Amt
Indicates the expended amount after correction.

New Actual Cost
Indicates the newly calculated actual cost for the corrected expenditure.

Reprocess
Reprocesses the expenditure as if it imported without an error. No change is actually made to
the expenditure but whatever mismatch caused the suspension has been corrected to allow the
expenditure to process correctly.

OK
Corrects the expenditure to either move it to the desired DCN/ACRN or correct the DCN/ACRN
to the correct JON. If you changed the JON only (no change to the expenditure DCN/ACRN), an
R type transaction will be created to change the JON in STARS-FL.
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Cancel
Aborts the action to correct the suspended expenditure and closes the window.

Help
Accesses the help topic on the Expenditure Correction window.

�  Steps for Correcting Suspended Expenditures

Use the Expenditure Correction window to make changes to a suspended
expenditure to unsuspend it. The process lets you correct a suspended expenditure
by changing the DCN/ACRN, or, in the case of a JON mismatch, the job order
number (JON). For detailed correction options, refer to the Expenditure Correction
help topic.

1. Select the Correct Suspended Expenditure item on the Utilities menu.

The Select Expenditure to Correct window will open, letting you select the desired
expenditure.
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Tip  To search for a specific document, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

2. Select the expenditure you wish to correct and select the OK button.

The Expenditure Correction window will open. Data that you change for the selected
expenditure displays on the drop-down fields. For this example, you can change the
DCN and/or ACRN.

Tip  To correct an expenditure for your site, the values displayed in the drop-down
fields must match the corresponding values displayed on the top portion of the
window. You should write the correct values down since you need to refer to them
when searching for the proper document and desired values(s), using a different
process in the Site application to correct the JON.

For the example shown, you will correct the JON to match the values indicated on
the top portion of the window. The correction of the JON is made on the Correction
After Export window.

To correct the DCN/ACRN, if applicable, select the desired value from the
appropriate drop-down list.

3. Select the OK button to close the Expenditure Correction window.
4. Select Update Document from the File menu or select the Update toolbar

button. The Select Document – Update window will open.
5. Search for the DCN that you wish to correct and select the OK button.

Tip  Refer to the Update Documents After Export topic in Chapter 6 if you wish to
view detailed information on the update documents process.

Figure 8.134
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The Correction After Export window will open.

6. Select the desired JON from the Job Order Number drop-down list.

If the correct value is not available for selection then the expenditure cannot be
corrected and you should return it to the FA, or wait until the JON is a valid job order
for your site, as applicable.

7. Select the Save button to save your change and close the Correction After
Export window.

8. Reopen the Expenditure Correction window for the applicable expenditure. Refer
to Steps 1 and 2.

9. Note that the Reprocess button is now available for selection. Select the button
to process the expenditure correction.

Figure 8.135
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Return Expenditure to the FA Process

�  Overview

Use the return expenditure to FA option to mark expenditures that will be returned to the FA in
the next accounting batch build or rebuild for export.

The return expenditure to FA option opens from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under Expenditure Return can return expenditures to the FA.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Expenditure Return prevents a user from returning expenditures to
the FA.

•  Mark Expenditures to Return to the FA Window Objects

Figure 8.137
Selecting the Return
Expenditure to FA
Option

Figure 8.138
Mark Expenditures to
Return to the FA
Window



Chapter 8 •   Run FASTDATA Site Utility Processes

FASTDATA Site Module User’s Manual 8 – 96 August 2003

Select the search type
You can search the listed expenditures by ACRN, DCN, Expenditure Amount, Expenditure
Date, or Expenditure Quantity. Select the desired search type from the drop-down list.

Enter the search item
Allows you to enter the desired value for the selected search type. For example, if you selected
DCN for the search type, enter the desired DCN in this field.

Select the sort order
Allows you to change the sort order of the data displayed on the Mark Expenditures to Return to
the FA window. Select the desired value from the drop-down list. Values include ACRN, DCN,
Expenditure Amount, Expenditure Date, or Expenditure Quantity.

Ascending
Select the Ascending radio button if you wish to sort the displayed data from smallest to
greatest.

Descending
Select the Descending radio button if you wish to sort the displayed data from greatest to
smallest.

Select
Indicates whether the expenditure will be returned to the FA when you build the accounting
batch and export data to the FA.

DCN
Identifies the document control number.

ACRN
Identifies the ACRN associated with the expenditure.

Expend Date
Identifies the date the expenditure was created.

Expend Amount
Identifies the cumulative amount expended to date against one ACRN of an obligating
document recorded for all receipt transactions.

Partial
Indicates whether the obligation is to be fully or partially liquidated when the expenditure is
processed.

Quantity Expended
Indicates the number of items being paid for by the expenditure.

--Expenditure Filter--
All Expenditures
Select this radio button to include all expenditures in the list.

Suspended Expenditures
Select this radio button to include only suspended expenditures in the list.
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Valid Expenditures
Select this radio button to include only valid expenditures in the list.

OK
Saves your changes and closes the Mark Expenditures to Return to the FA window.

Cancel
Closes the window without saving any changes you may have made.

Help
Accesses the reference help topic on the Mark Expenditures to Return to the FA window.

�  Steps for Returning Expenditures to the FA

Use the Mark Expenditures to Return to the FA window to identify expenditures to
return to the FA. Expenditures that you can return include suspended expenditures
that the FA has not corrected as well as valid expenditures that are not part of a cost
redistribution.

1. Select the Return Expenditure to FA item on the Utilities menu.

Figure 8.139
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The Mark Expenditures to Return to the FA window will open, letting you select the
expenditures that you wish to return. If you wish to apply a filter, select the desired
Expenditure Filter radio button.

Tip  DMLSS expenditures are not made available for return to the FA.

Tip  To search for a specific expenditure, select the desired search type from the
Select the search type drop-down list. Enter the desired value for the selected
search type in the Enter the search item field. If you wish to change the sort order
of the listed documents, select the desired value from the Select the sort order
drop-down list and choose the desired sort order type radio button: Ascending or
Descending.

2. Check the expenditure(s) you wish to return and select the OK button. The Mark
Expenditures to Return to the FA window will close.

Quarterly and Year End Data Processing

�  Overview

Use the process quarter and process year end options to carry Site data into the next quarter or
fiscal year, as applicable. There are no specific windows associated with the processes. Rather,
FASTDATA displays a series of messages during the processing to which the user must
respond.

Figure 8.140
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The process quarter option opens from the FASTDATA Site Utilities menu.

The process year end option opens from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under System Utilities can perform quarterly and year end
processing.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under System Utilities prevents a user from performing quarterly and year
end processing.

Figure 8.141
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�  Steps for Performing Quarterly Processing

Use the process quarter option to bring authorization amounts into the new quarter.
When it is time to perform quarterly processing, FASTDATA will notify you when you
log into the Site. Select the OK button to proceed. The Utilities menu Process
Quarter item is not selectable unless it is time for quarterly processing.

1. Select Process Quarter from the Utilities menu. FASTDATA will ask you to
confirm that you want to roll over the quarter.

2. Select Cancel if you wish to abort the rollover process. Select OK to continue.
3. Select OK on the message informing you that the current quarter has been

changed.

�  Steps for Performing Year End Processing

Use year end processing to roll your site data into the new fiscal year. Doing so will
remove the oldest fiscal year and its associated data. For sites with a DMLSS FA,
the Total Inventory Issued amounts also will reset to zero for the new fiscal year.
When year end processing is complete, FASTDATA will change the new active fiscal
year to the new current fiscal year and will create a new outyear.

NOTE  You must first import the FA's end-of-year data, using the Import System
Information option, before you can perform year end processing.

NOTE   To perform year end processing, you must be in the current fiscal year.
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1. Select Process Year End from the Utilities menu. FASTDATA will ask you to
confirm that you want to roll over data to the next fiscal year.

2. Select No if you wish to abort the rollover process. Select Yes to complete the
rollover process. FASTDATA will inform you that the process has successfully
been completed.

3. Select the OK button to close the message window.

Recalculate Obligations

�  Overview

Use the Job Order Recalculation window if the site funds as shown in the Status of Funds
Report and the Document Status Report are out of balance. The recalculation process will verify
the actual costs of each document and adjust the obligated amounts on each job order number
(JON) to bring them back in balance. The main portion of the Job Order Recalculation window
displays the results of the recalculation process.

The Job Order Recalculation window opens from the FASTDATA Site Utilities menu.
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Restrictions

•  Access to the Job Order Recalculation window is unrestricted.

•  Job Order Recalculation Window Objects

Print
Opens the Quick Print window, allowing you to print the results of the recalculation process.

Close
Closes the Job Order Recalculation window.

Help
Accesses this topic in reference help.

� Steps for Recalculating Obligations

Use the Job Order Recalculation window when your funds are out of balance and
you wish to bring them back into balance. When you open the Job Order
Recalculation window, the recalculation process runs automatically. The window
provides messages during the process and also lets you know when the process is
complete. If you wish, you can view or print a report of the recalculation process
results by selecting the Print button.

1. From the FASTDATA Site window, select Recalculate Obligations from the
Utilities menu.

The Job Order Recalculation window will open and the recalculation process will
launch automatically.

Figure 8.148
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2. Select the Print button if you wish to open the Quick Print – Job Order
Recalculation window.

3. Use the horizontal and vertical scrollbars on the Quick Print window to change
the view of the displayed data.

Tip  The scrollbars only allow you to scroll the displayed page. Use the VCR buttons,
if applicable, to select a different page to view.

4. Select the window-specific Print toolbar button to print the data.
5. Select the Save As picture button if you wish to save the report as a file.
6. Select the Close button to close the Quick Print - Job Order Recalculation

window.
7. Select the Close button to close the Job Order Recalculation window.

Suspend Transactions

�  Overview

Use the Suspend Transactions window to mark transactions for suspension. The list of available
transactions that displays on the window includes all transactions that have not been cross-
referenced to a credit card document and that have been created or changed since the FA last
received transactions from your site.

For Oracle® users sharing an integrated database with their FA, your FA may have set up an
automated process to retrieve new or changed transactions from your site automatically. If your
FA has set up such a process to run more frequently than daily, when you create or update a
transaction you know you wish to suspend, immediately suspend the transaction so it will be
marked for suspension when the automatic process runs. For the automated process that runs
every X minutes, when you add or update a transaction, the new or changed transaction will be
included not in the next automatic export but rather the export after that. Skipping one cycle of
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the automatic process should give you enough time to suspend the desired transactions before
they go to the FA automatically. If an automated process runs automatically while you have the
Suspend Transactions window open, any transactions eligible for suspension is not included in
the automated export to the FA.

For sites where transactions are not automatically retrieved by the FA, the transactions marked
for suspension are included the next time you export comptroller data.

Until the transactions marked for suspension have been received by the FA, you can access the
Suspend Transactions window anytime and unmark transactions previously marked for
suspension. If you unmark a suspension, you must also delete the suspension reason.

The Suspend Transactions window opens from the FASTDATA Site Utilities menu.

Restrictions

•  Only users with a FASTDATA FA Module Site User Maintenance window Site Security
Access option of Access under Suspend Transactions can suspend transactions.

•  A FASTDATA FA Module Site User Maintenance window Site Security Access option of
No Access under Suspend Transactions prevents a user from accessing the Suspend
Transactions window.
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•  Suspend Transactions Window Objects

Select the search type
You can search by DCN, Job Order, Transaction Amount, Transaction Code, or
Transaction Date. Select the desired search type from the drop-down list.

Enter the search item
Allows you to enter the desired value for the selected search type. For example, if you selected
DCN for the search type, enter the desired DCN you wish to search for.

Select the sort order
Allows you to change the sort order of the data displayed on the Suspend Transactions window.
Select the desired value from the drop-down list. Values include  DCN, Document Type, Job
Order, Transaction Amount, Transaction Code, or Transaction Date.

Ascending
Select the Ascending radio button if you wish to sort the displayed data from smallest to
greatest.

Descending
Select the Descending radio button if you wish to sort the displayed data from greatest to
smallest.

Suspend
Controls and indicates whether the listed transaction will be suspended when the FA imports the
accounting batch file from your site. If checked, the transaction will be suspended.

DCN
Identifies the document control number.

Suspension Reason
Identifies why the transaction is being suspended. You can enter up to 200 characters. Most
special characters except the semicolon (;) are allowed in the Suspension Reason text.
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Amendment
Identifies a specific official amendment to a previously established financial document.

ACRN
Identifies the transaction ACRN.

Job Order
Identifies the listed transaction's JON.

Transaction Amount
Identifies the amount of the transaction.

Transaction Date
Identifies the date the transaction was generated.

Transaction Code
A two-character code that identifies the nature of the transaction. Valid values include AD
(Obligation created with a Category 2 DD448), AO (Obligation), AR (Obligation created with a
Category 1 acceptance), CM (Commitment), EC (Civilian Labor Expenditure), EV (Expenditure),
RG (Government Receipt), RP (Public Receipt), RT (Modification to JON, Expense Element, or
OMB Object Class), and UT (Modification to contract or BPA).

Document Type
Identifies a specific document form number.

Partial/Final
Identifies the type of transaction. Valid values include C (Cancel), F (Final), I (Initial), L
(Liquidation), P (Partial), R (Modification to JON, Expense Element, or OMB Object Class), T
(Adjustment to existing commitment or obligation), and U (Modification to contract or BPA).

OK
Saves your changes and closes the Suspend Transactions window.

Close
Closes the Suspend Transactions window.

Help
Accesses this topic in reference help.

� Steps for Suspending Transactions

Use the Suspend Transactions window to mark transactions as suspended. When
you export the accounting batch file to the FA, marked transactions will be
suspended. You also can use the window to unsuspend previously suspended
transactions that have not yet been received by the FA.

1. From the FASTDATA Site window, select Suspend Transactions from the
Utilities menu.
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The Suspend Transactions window will open and allow you to mark one or more
transactions for suspension.

2. Check the Suspend check box for each listed transaction you wish to suspend.
3. Enter a required reason for the transaction suspension in the Suspension

Reason text box. You can enter up to 200 characters.

To unmark a previously suspended transaction, uncheck the desired Suspend check
box and delete the Suspension Reason.

4. Select the OK button to save your changes and close the Suspend Transactions
window.
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